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#1: You don’t have to read 
this book in order.

I designed this book so you can turn 
right to the technique you want to learn, 
and start there. I explain everything as 
I go, step by step, so if you want to 
learn how to remove dust spots from 
an image, just turn to page 46, and in 
a minute or two, you’ll know. I did write 
the book in a logical order for learning 
Photoshop, but don’t let that tie your 
hands. Jump right to whatever tech-
nique you want to learn—you can always 
go back, review, and try other stuff.

#2: Practice along with many 
of the same photos I used 
here in the book.

As you’re going through the book, and 
you come to a technique like “Creating 
Panos,” you might not have a set of 
pano shots just hanging around, so in 
those cases, I usually made the images 
available for you to download so you 
can follow along with the book. You 
can find them at http://kelbyone.com
/books/ps23 (see, this is one of those 
things I was talking about that you’d 
miss if you skipped this and went right 
to Chapter 1).

It’s really important to me that you get a lot out of reading this book, and one way I can help is to get you to read these 

seven quick things about the book that you’ll wish later you knew now. For example, it’s here that I tell you about where 

to download the images I used here in the book so you can practice with them, and if you skip over this, eventually you’ll 

send me an email asking where they are, but by then you’ll be really aggravated, and well…it’s gonna get ugly. We can skip 

all that (and more), if you take two minutes now and read these seven quick things. I promise to make it worth your while.

Seven Things You’ll Wish You Had Known 
Before Reading This Book
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#3: You’ll be using a lot of 
Camera Raw, even if you 
don’t shoot in RAW.

The photographer’s workflow in Photo-
shop has evolved greatly over time and, 
thus you’ll wind up doing a lot of stuff in 
the Adobe Camera Raw part of Photo-
shop. Don’t worry, you do not have to 
shoot in RAW to use Camera Raw. It works 
with JPEGs or TIFFs just fine. One big 
reason is because Adobe has been add-
ing most of Photoshop’s new features 
for photography into Camera Raw and 
they only exist there, including the new 
game-changing AI masking features, and 
much of today’s photography workflow in 
Photoshop is based around Camera Raw. 
I wanted you to know this up front since 
we’ll be going to Camera Raw, either at 
the beginning of the process, or just using 
it as a filter, quite a bit throughout. It’s a 
key part of the modern workflow, and like 
I said, you absolutely don’t have to shoot 
in RAW to use Camera Raw—it works with 
great with JPEGs, too. 

#4: Warning: The Chapter Intro 
Pages Are Pretty Whacked!

In a normal book, the intro page at the 
beginning of each chapter gives you 
some important insight into the coming 
chapter. But, mine really don’t. These 
brief, quirky, rambling intros have little 
to do with what’s actually in the chapter. 
They’re designed simply to give you a 
“mental break” between chapters, and 
they’ve become a tradition in all of my 
books. A lot of folks love them (so much 
so, that we published an entire book 
of nothing but these chapter intros. 
I am not making this up), however some 

“serious folks” hate them with the pas-
sion of a thousand burning suns, so I’m 
warning you now in case you’re one of 
those serious folks who hate stuff like 
that. If that sounds like you, I’m begging 
you, please just skip the chapter intros 
altogether, because the rest of the book 
is really straightforward. 
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#5: There are things in Photoshop 
and in Camera Raw that 
do the exact same thing.

For example, there are lens corrections in 
Camera Raw’s Optics panel, and there’s 
a Lens Correction filter in Photoshop. In 
my own workflow, if I can do the exact 
same task in Camera Raw and Photo-
shop, I always choose to do it in Camera 
Raw because (a) it’s faster (there are no 
progress bars in Camera Raw—every-
thing happens in real time), (b) it’s non-
destructive (so you can always change 
my mind later), and (c) if you shot in RAW, 
it applies the edits to the RAW 16-bit 
image, which has a wider tonal range, 
and even heavy amounts of editing will 
do less visible damage to the image. So, 
if I’m showing you something in Camera 
Raw that can also be done in Photoshop, 
I may mention it, but I’ll only show it in 
Camera Raw (since that’s how I do it).

#6: Where’s the Adobe 
Bridge stuff?

Adobe hasn’t done much with Bridge 
for years now. I don’t want to say it’s 
abandoned, but kinda. I’m thinking 
the future of Bridge is not bright, and 
since it hasn’t changed much in years 
(and it’s slower than an asthmatic three-
toed sloth covered in molasses, going 
uphill on a sand dune), I’m no longer 
including it here in the book. But, if 
you’re brand new to Photoshop, you 
don’t use Lightroom, and you think you 
might need Bridge (please, rethink it), 
I did write two entire chapters just on 
Bridge and put them for you on the 
book’s download page for you to down-
load for free. You’ll find these at http:

//kelbyone.com/books/ps23, along 
with two other bonus chapters on print-
ing and editing video (see, I care).
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#7: There really isn’t 
a seventh thing…

…but saying “Six Things...” won’t get 
anybody to read anything. Seven is kind 
of a magical number (especially when 
it comes to book introductions), so 
I hope you’ll forgive me for exaggerat-
ing the number of important things. 
Okay, you’re ready to get to work. Time 
to unleash the magic and mayhem that 
is the wonderful world of Photoshop. 
Let’s go!
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Chapter 5 Working with Layers

Okay, it’s another chapter and another opportunity to provide 
an invisible chapter name from a movie or song (though I don’t 
think we’ve actually named any chapters after a song so far). Ya 
know, this process of writing chapter intros is more complicated 
than you’d think, and it usually takes longer to write one of 
these chapter intros than it does to write one of the tutorials in 
a chapter. The reason is: it doesn’t really matter if the tutorials 
work or not because, at this point, you’ve already bought the 
book (and more often than not, they don’t work at all, but 
that’s not why you bought the book. It’s for these intros). But, 
these chapter intros are complex. They have to be spell-checked 
and need approximately 70% of the grammar to be at least in 
the ballpark, plus they need commas and stuff, and well, quite 
frankly, they’re a lot of trouble. Writing these intros is a process, 
and I have to be in the right frame of mind to write at this 
low/high level. So, if you’re thinking that when I write these, 
I’m sitting in my wife’s art studio in a cozy chair, with a throw 
blanket, with my feet up and a cold glass of Diet Coke on ice 
within reach on a small side table, with the dogs curled up 
napping on the floor as a warm instrumental jazz Spotify playlist 
is playing softly in the background, and sunlight fills the room 
on a warm Florida day, boy are you way off. Geesh, you don’t 

know me at all, and that’s disappointing because here we are 
at, what is this, like Chapter 5, and I thought by now we’d be 
close, like best buds. Well, to give you a peek into what my 
writing life is really like (so we can bond over it), here’s how 
I write these intros: First, I’m usually in a national park, probably 
Yosemite, and I’m sitting cross-legged under a tree, wearing a 
hand-woven Guatemalan pancho, with Yosemite falls roaring 
gently in the background, as a fawn scampers by after picking 
up the acorns and apples I had carefully laid out for her. The 
soundtrack for my writing is “Fantasia de Mon Triste” from 
La Compagna played on the lute. I nibble on wild berries, 
walnuts, and other healthy snacks as I sip cool, fresh water from 
the falls in a hand-crafted, eco-friendly cup carved from a burl 
of a birch tree. One reason the chapter intro writing process 
takes so long is that I don’t write on my laptop. I exclusively 
write by hand using a Caran d’Ache Ecridor retro palladium-
coated fountain pen on crisp, white, feathery sheets of 
A4-sized Clairefontaine Triomphe stationery with a thickness of 
90g/m2. So, if that’s what you were picturing when you think 
of me writing these chapter intros, you totally “get me.” This 
closeness we share is sometimes scary. It’s often hard to know 
where you start and I begin. #truth
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Getting Started with Layers
Layers are one of the most powerful features in Photoshop because they do so much. A layer 

lets you add something on top of your image and position it wherever you’d like. For example, 

say you’d like to add a graphic or type to a wedding book page, or you’d like to blend 

two photos together for a fine art effect, you can do this with layers. Plus, we use layers for 

everything from fixing problems to special effects. Here are the basics on how layers work:

Step One:
Open an image and if you look over in 
the Layers panel (it’s found under the 
Window menu if it’s not already open), it 
will appear as the Background layer (as 
seen here). Let’s add some type here to 
appear over our image. 

Step Two:
Get the Horizontal Type tool (T) from 
the Toolbox (as shown here), then click 
on your image and start typing. This 
creates a Type layer and you can see 
this over in the Layers panel (it’s the one 
stacked above the Background layer; 
the letter “T” thumbnail lets you know 
at a glance that this is a Type layer). Type 
in the phrase “always and forever…” (as 
shown here). The font I’m using is called 

“Cezanne” from the font developer P22, 
but you can use any script font you’d 
like (you choose your font and font size 
from the Options Bar near the top of the 
interface. You’ll see a font pop-up menu 
and a size field there where you can type 
in the point size you’d like. You can also 
choose the color here). 
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Step Three:
Once you’ve got your type in place, it’s 
floating above the background on its 
own separate layer, so you can easily 
reposition it by switching to the Move 
tool in the Toolbox and just clicking-
and-dragging it (the Move tool is the 
topmost tool in the Toolbox). If you look 
at the type here, the left side of it is kind 
of hard to read because it blends in with 
the sofa, so let’s put a white bar behind 
the type to make it stand out. To add a 
new blank layer, click on the Create a 
New Layer icon at the bottom of the 
Layers panel (it’s circled here in red). 
Now, get the Rectangular Marquee 
tool (M) from the Toolbox and click-and-
drag out a thin, wide rectangle from side 
to side. Make it a little larger than the 
text, like you see here. Next, we want to 
fill this rectangle with white, so we need 
to set white as our Foreground color. 

Step Four:
An easy way to do that is to first set your 
Foreground and Background colors to 
their default settings by pressing the D 
key. That makes black your Foreground 
color and white your Background color. 
However, we need to swap those two 
colors, so white is the Foreground color 
and black is the Background color (you 
can see their swatches near the bottom 
of the Toolbox). To do that, just press 
the X key. Now, to fill our rectangular se-
lection with white, press Option-Delete 
(PC: Alt-Backspace), and then Deselect 
the selection by pressing Command-D 
(PC: Ctrl-D). This white bar now cov-
ers our type because it’s “above” our 
Type layer in the Layers panel (the bride 
image is at the bottom of the layer stack, 
the Type layer is on top of that, and the 
white bar is above the Type layer, so it 
covers it up). We need the white bar to 
appear behind our Type layer, not cover-
ing it up, so we just need to change the 
order of the layers.
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Step Five:
Go to the Layers panel, click on the top 
layer (the white bar; Layer 1) and drag 
it down below the Type layer. Now, the 
type is visible again because the Type 
layer is at the top of the layer stack (as 
seen here, in the Layers panel). So, the 
stacking order has changed. The bride 
is still on the Background layer, the white 
bar layer is in the middle now, and the 
Type layer is on top. Let’s go ahead 
and rename Layer 1 (the white bar), so 
it’s easier to keep track of. In the Lay-
ers panel, double-click directly on the 
words “Layer 1” and it highlights so you 
can type in a new name (I named mine 

“White Bar.” I know. How original). By 
the way, Type layers automatically name 
themselves with the first few words you 
typed, so you don’t have to rename 
them unless you really want to. 

Step Six:
We could leave the white bar solid white, 
but one of the nice features of layers is 
the ability to change their opacity. Let’s 
make that white bar a bit transparent, so 
you can see the image behind it. It will 
still do its job of making the type easier 
to read, but it won’t block as much of 
the photo if it’s a bit see-through. To do 
this, go near the top right of the Layers 
panel and you’ll see an Opacity field. By 
default, it reads 100%, but if you click 
on the little down-facing arrow to the 
right of its field, a slider appears and you 
can drag that slider to the left to lower 
the Opacity of that white bar (here, I 
lowered it to 60%). Now you can see 
through that white bar a bit, so it’s not 
covering as much of the image on the 
Background layer.
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Step Seven: 
It seems like our type and our white bar 
are maybe a little too high up in the 
image, so let’s fix that. Get the Move 
tool (V) from the Toolbox (it’s circled 
here in red), and in the image window 
(not in the Layers panel; it’s already our 
active layer), click directly on the white 
bar and drag it straight downward a 
couple of inches or so (like you see here). 
By the way, to make it drag perfectly 
straight down, press-and-hold the Shift 
key while you drag. Next, we’ll do the 
same thing with our Type layer. 

Step Eight: 
To move the Type layer, we’ll have to 
go to the Layers panel and click on 
that layer to make it the active layer (so 
things we do now will affect the Type 
layer, and not that white bar layer where 
we had been working). Once you click 
on the Type layer, with the Move tool 
still selected, click-and-drag the type 
on the image straight downward, so it’s 
over the white bar again. Now that we 
have it down there, let’s try something 
different: If you drag the text over to 
the right a bit, so it’s fully over her dress 
(like you see here), we don’t need that 
white bar at all, so let’s get rid of it. We 
can either hide it from view by clicking 
on the eye icon to the left of the layer’s 
thumbnail in the Layers panel, or we 
can delete it by hitting the Delete (PC: 
Backspace) key, or we can click-and-
drag that layer down to the trash can 
icon at the bottom of the Layers panel 
(shown circled here in red). Okay, there 
ya have it—the basics of working with 
layers. Now you know how to add new 
layers, add a Type layer, reorder your 
layers, change their opacity, and delete 
them. We’re off and running.
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Blending Two or More Images (Intro to Layer Masks)
I’m sure you’ve seen many examples where one image blends smoothly and seamlessly into another image. Well, thanks to layers 
and layer masking, it’s super-simple to do. When you add a layer mask, you’re telling Photoshop, “I only want to show part of what’s 
on this layer,” and then you can use either the Brush tool or the Gradient tool (my favorite) to pick which parts of that layer you 
want visible and which parts you want hidden. Using a large, soft-edged brush, or the Gradient tool, can make the blend between 
images really nice and smooth. Just as a heads-up as we get into this: any parts of a layer mask that appear in black, that part 
of the image will be hidden (concealed), and any parts that appear in white will be visible (revealed). A phrase we’ve been using 
since prehistoric times to help us remember this is: “Black conceals and white reveals.” This will make more sense shortly.

Step One: 
We’re going to blend three images to-
gether here. I usually pick one to start 
with as my “base” image, and in this case, 
I chose this image of a restaurant menu. 

Step Two: 
Open the first image you want to blend 
with the menu image—in this case, it’s a 
photo of a champagne bottle. We need 
to get this image over onto our menu 
image, and the easiest way to do this 
is to copy-and-paste this layer over into 
the other image (yes, you can copy-and-
paste layers between documents). The 
only problem is, it doesn’t let you copy-
and-paste Background layers (ugh!), so 
we’ll just convert this Background layer 
into a regular layer. We do this by simply 
clicking once on the little lock icon to 
the right of the word “Background” (as 
shown here). That’s it. One click and it’s 
a regular layer (I know, it seems like it 
should be more complicated than that). 
Now, press Command-C (PC: Ctrl-C) to 
Copy this layer into memory.
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Step Three: 
Go back to the menu image and press 
Command-V (PC: Ctrl-V) to Paste this 
champagne bottle image right over the 
menu image. Of course, when you do 
this, the champagne image will cover up 
the menu, and that’s okay (that’s how it’s 
supposed to work). We’re going to add 
a layer mask to create a smooth blend 
between the two images, and it’s just 
three easy clicks: (1) Click on the Add 
Layer Mask icon at the bottom of the 
Layers panel (it’s shown circled here in 
red). Then, (2) get the Gradient tool (G)
from the Toolbox (it’s circled in red, too). 
Lastly, (3) take that Gradient tool, click 
it where you want our champagne bottle 
image on the top layer to be transparent, 
and then drag over to where you want it 
to be visible. Here, I clicked to the right 
of the bottle (whereI want the menu 
to be visible), and then I dragged over 
to the bottle, and it made a smooth 
transition between the menu and the 
champagne bottle. 

Step Four:
Take a look at the Layers panel in the 
previous step, and you’ll now see a sec-
ond thumbnail to the right of the original 
champagne bottle layer’s thumbnail. 
That’s the layer mask thumbnail. See how 
it’s black on the right side? That’s show-
ing you that part of the bottle image is 
hidden from view (concealed), and as it 
graduates over to white on the left, the 
bottle becomes visible (revealed). That’s 
why we say, “black conceals and white 
reveals.” Okay, that bottle seems a little 
too far into the image, so get the Move 
tool (V) from the top of the Toolbox, 
click on the bottle, and drag it over to 
the left a bit, so it’s not so far into the 
image (as seen here). Next, let’s add the 
third image. 
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Step Five:
Let’s open the image of a fresh tomato 
and mozzarella caprese salad. Let’s first 
convert it to a regular layer by going 
to the Layers panel and clicking on the 
lock icon (when you do this, the name 
changes to “Layer 0” and the lock icon 
disappears, as seen here, in the inset). 
Now we can Copy this layer into memory 
by pressing Command-C (PC: Ctrl-C). 

Step Six:
Go back to the menu image document, 
and then press Command-V (PC: Ctrl-
V) to Paste the caprese salad layer into 
our menu document. Now, using the 
Move tool, slide that image over to 
the right (as shown here). Okay, the 
image has a hard edge on the left and it 
doesn’t blend, so in the next step, we’ll 
create that smooth blend using a layer 
mask and the Gradient tool. 
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Step Seven:
Click on the Add Layer Mask icon at the 
bottom of the Layers panel, and then 
get the Gradient tool again from the 
Toolbox. Now, click the Gradient tool 
where you want the image on the top 
layer to be transparent, and then drag 
over to where you want it to be visible. 
Here, I clicked on the plate (I want that 
part to be transparent), then I dragged 
over to the middle of the tomatoes, and 
it’ll create that smooth graduation be-
tween the menu and salad (as seen in 
the next step). 

Step Eight:
Here you can see the smooth blending 
of the images, thanks to those gradients 
on the layer masks. Now, let’s get the 
Move tool again, and drag both the 
champagne bottle and the salad out 
over toward the edges a bit, so they 
don’t overtake the image too much. 
Here’s the final image, and your intro-
duction to layer masks for blending. By 
the way, as I mentioned in the introduc-
tion, you can also use the Brush tool the 
same way. If you paint in black, it would 
hide any areas you painted over. Or, if, 
for example, here you wanted to see 
more of the tomatoes, you would paint 
over them in white. Use a large, soft-
edged brush to keep all the edges soft 
and blending smoothly.
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Layer blend modes are awesome because they let you choose how the layer you’re working on blends with the layer(s) below it. 

When your layer blend mode is set to Normal, it doesn’t blend—whatever’s on this layer covers up whatever’s on the layer(s) below 

it. But, when you choose a blend mode, now it blends, and it looks different based on which blend mode you choose. Besides 

Normal mode, there are 26 different blend modes, but to be honest, in your day-to-day work, you’re really only going to use four 

of them: Multiply, Screen, Overlay, and Soft Light. There will be a time here and there that you’ll wind up using one of the others, 

maybe for a special effect or a retouching task, but for the most part, it’s just those four. Here’s what they do and how they work:

Getting Started with Layer Blend Modes

Step One:
You need to have a layer to get layer 
blend modes to work, so open an image, 
and then press Command-J (PC: Ctrl-J) 
to make a duplicate of the Background 
layer (you can see this new layer, named 

“Layer 1” by default, in the Layers panel). 
Now, near the top left of the Layers 
panel, you’ll see a pop-up menu set to 
Normal, by default (as seen here in the 
red rectangle). 

Step Two:
To see the different layer blend modes, 
click-and-hold on the word “Normal,” 
and the pop-up menu of blends modes 
appears (as seen here). To see how this 
top layer would look with a layer blend 
mode applied, scroll over any of the 
blend modes in this menu, and you’ll 
see the results of each one appear on-
screen. You can also use the Up/Down 
Arrow keys on your keyboard to scroll 
through the menu to sample each one. 
Here, I chose Multiply, which is a mode 
that multiplies the color in the image, 
making it look much darker. I use this 
mode quite a bit when I’m editing an 
image to see how it would look darker 
and more dramatic.
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Step Three:
Here’s another one of the four most-
used blend modes: Screen. It makes your 
image appear much brighter (as seen 
here). This is a great way to quickly see 
how your image would look with a bright 
high-key look. If you apply a blend mode 
and think it’s too intense (in this case, 
it’s too bright), you can simply lower the 
Opacity amount for this layer (up near 
the top-right corner of the Layers panel) 
to dial back the amount of the effect (so, 
if you want this to look less bright, lower 
the Opacity). 

TIP: Another Way to Audition 
Layer Blend Modes

You don’t have to click-and-hold on that 
pop-up menu—you can scroll through 
and audition any of the blend modes 
by pressing Shift-+ to move forward 
through them, or Shift-– to scroll back-
ward through them. 

Step Four:
Next, let’s switch to Overlay mode, which 
adds a lot of contrast to your image (as 
seen here). Now, didn’t I say there were 
four most-used blend modes? Yes, but 
the last one is pretty much like this one. 
It’s Soft Light, which is pretty much a 
less powerful version of Overlay. If there 
were a fifth most-popular layer blend 
mode, it would probably be Color, which 
lets you add a color to your image with-
out covering the layer with color—the 
color blends in with the image below it.
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#1: How to Duplicate a Layer
To duplicate a layer, click on the layer in 
the Layers panel and press Command-
J (PC: Ctrl-J). This works whether it’s 
a regular layer or the Background layer. 
Weird thing: if you duplicate the Back-
ground layer, it names the duplicate 

“Layer 1” (as seen here). Not weird yet. 
If you duplicate that layer, it doesn’t 
name it “Layer 2.” It names it “Layer 
1 copy.” Weird.

#2: Moving Multiple Layers
If you want to move multiple lay-
ers in your image at the same time, 
there are two ways to do this: (1) Click 
on the first layer you want to move, 
then press-and-hold the Command 
(PC: Ctrl) key, and then click on the 
other layers you want to move at the 
same time to select them (I’ve Com-
mand-clicked on three layers here, 
and all three are highlighted). Now, 
when you drag any of those layers in 
your image, all of your selected lay-
ers move as one unit. That method 
moves them only as long as they’re 
selected. If you want something more 
permanent, you can Command-click 
on the layers you want, and then click 
the Link Layers icon at the bottom of 
the Layers panel (shown circled here). 
Now, those panels stay linked to each 
other until you click that icon again.

These are some of those things you’ll want to know before we move on 

because we use a lot of these things in our day-to-day layers work.

Five Layers Things to Know 
Before We Move On
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#3: Quickly Move a Layer 
in the Layer Stack

If you want to quickly move a particular 
layer to the top of the layer stack (as 
seen here on the right), click on the 
layer, and then press Command-Shift-] 
(Right Bracket key; Ctrl-Shift-]). You can 
move any layer to the bottom of the 
stack using the same shortcut, but just 
use the Left Bracket ( [ ) key instead. 

#4: How to Merge Two 
or More Layers

If you have two layers that you want to 
be just one, click on the top layer and 
press Command-E (PC: Ctrl-E). If you 
want to merge more than two layers 
together, press-and-hold the Command 
(PC: Ctrl) key, click on the layers you want 
to merge into one, and then press the 
same keyboard shortcut. 

#5: How to Flatten Your Layers
When you’re done working with your 
layers and you want to flatten your 
image—keeping the same look as your 
current image—go to the Layers panel’s 
flyout menu (at the top-right corner of 
the panel), and down near the bottom, 
choose Flatten Image (as shown here).
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Adding Drop Shadows and Other Layer Effects
What’s interesting (and important) to know about adding layer effects, like a drop shadow or a glow, is that it doesn’t just apply 

the effect to your object (in this case, we’re applying a drop shadow to a guitar), but instead, it applies the effect to that entire layer. 

So, anything you do on that layer will have a drop shadow added to it. For example, if you grabbed the Brush tool and painted a 

few red strokes on your guitar layer, those strokes would have the exact same drop shadow you applied to the guitar applied to 

them. That’s why they’re called “layer effects” and not “effects.” Whatever you choose, it gets applied to the entire layer.

Step One:
Open an image you want to apply a 
drop shadow to (in this case, it’s a gui-
tar. Don’t forget, you can download this 
same practice image from the book’s 
companion website. The URL can be 
found in the book’s introduction). Since 
the guitar is on the Background layer, 
we can’t add a layer effect to it—it’s 
technically not a “real” layer yet, but we 
can fix that. First, go under the Select 
menu up top, choose Subject, and it 
will select our subject (in this case, the 
guitar). Next, press Command-J (PC: 
Ctrl-J) to put that selected guitar up on 
its own separate layer, minus the white 
background because we selected just 
the guitar itself (as seen here, in the 
Layers panel. That checkerboard pat-
tern you see on Layer 1’s thumbnail 
shows you the areas on that layer that 
are transparent—all those areas around 
the guitar). 

Step Two:
To apply a drop shadow (or any one of 
the 10 different layer effects), click on 
the Add a Layer Style icon (the fx) at 
the bottom of the Layers panel (it’s the 
second one from the left), and from the 
bottom of the pop-up menu, choose 
Drop Shadow (as shown here).
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Step Three:
When you choose Drop Shadow, the 
Drop Shadow options appear in the 
Layer Style dialog (seen here), and it 
applies a drop shadow to any objects 
on this layer. The default settings were 
made a long, long time ago when file 
resolutions were much, much lower, 
so these settings are so subtle you 
probably won’t even be able to see 
that a drop shadow has been added 
(as seen here. Don’t worry, you can 
set your own defaults from here on 
out, but for now, your drop shadow is 
nearly invisible). 

Step Four:
The first thing we’re going to do is 
choose where we want our drop shadow. 
There are Angle and Distance settings 
to figure out the exact proper angle, but 
unless you’re a nerd, there’s a better 
way: a visual way where you put the 
shadow exactly where you want it with-
out the math. Just move your cursor 
outside the Layer Style dialog, right out 
onto your image, and click-and-drag 
on your image to drag the shadow right 
where you want it. Here, I clicked on 
the guitar (since the shadow was hid-
den behind it with the default settings) 
and dragged the shadow down and to 
the right, so we can now at least see it. 
As a general rule, the farther away the 
shadow is from the object, the higher 
it appears off the background. You’ll 
notice the shadow is hard-edged, so 
we’ll need to soften it up a bit in the 
next step. 
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Step Five:
The Size slider controls the softness of 
the shadow (I know. Why isn’t it named 
blur or softness? Don’t get me started). 
Here, I increased the Size slider (soft-
ness) to 133 pixels and you can see the 
shadow looks much softer (it goes up to 
2,000 pixels). You control the darkness 
of the drop shadow using the Opacity 
slider up near the top. Here, I increased 
the Opacity slider from 35% (the 
default) to 43% to make the shadow 
darker. One more thing before we 
move on: Notice that Use Global Light 
checkbox? What that means is, if you 
add more layers in this document, it 
will apply this same shadow, with the 
same angle and distance. If you were 
to change the angle or direction on any 
layer, all the other layers you applied a 
drop shadow to will all move, as well. 
The shadows move together—globally. 
Okay, let’s take a look at a different 
effect just to say we did. 

Step Six: 
Let’s turn off the drop shadow effect for 
now. You see that list of effects along 
the left side of the Layer Style dialog? 
Turn off the Drop Shadow checkbox
(as seen here, below left). Okay, now 
that it’s off, let’s try an outer glow ef-
fect. But first, click OK at the top right 
to close the dialog for a minute. In the 
Layers panel, click on the Background 
layer to make it the active layer (as seen 
here, below right), press the D key to 
set your Foreground color to black, and 
then press Option-Delete (PC: Alt-
Backspace) to fill the Background layer 
with black. This way, we can clearly see 
the glow once we apply it. While we’re 
here, take a look in the Layers panel 
and notice that the word “Effects” ap-
pears right below the guitar layers’s 
thumbnail (that lets you know a layer 
style was applied), and below that is 
the name of the effect (Drop Shadow). 
More on this in a moment.
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Step Seven: 
To apply an Outer Glow layer style, click 
back on Layer 1 in the Layers panel, 
then click on the Add a Layer Style 
icon again, choose Outer Glow, and 
it applies the glow effect, which you 
can barely see because (once again) 
the defaults were created a long time 
ago for much lower-resolution images. 
Speaking of defaults, once you come up 
with some settings you like better (trust 
me, it won’t be hard), click the Make 
Default button near the bottom center 
of the Layer Style dialog and now your 
new settings are the new defaults. So, 
when you apply an outer glow it will 
apply your new defaults, instead of 
Adobe’s old ones. Same thing for the 
other layer styles. Okay, let’s tweak that 
glow a bit. 

Step Eight:
To increase the size of the glow, drag the 
Size slider to the right (here, I dragged 
it over to 196 pixels). To make the glow 
more visible, increase the Opacity slider
(as I did here, to 75%). The various layer 
styles have a lot in common, so once you 
learn how to use one, the others have 
many familiar sliders and checkboxes. 
Also, take a look over at the Layers panel, 
below the guitar layer, and you can see 
under the word “Effects,” it now shows 
that two layer styles have been applied 
to this layer (you can apply all 10 if you 
want). But, also look to the left of Outer 
Glow—it has an eye icon. That lets you 
know that effect is visible. The Drop 
Shadow doesn’t have an eye icon here 
because we hid it earlier by turning off 
its checkbox in the Styles list. You can 
show or hide effects right from the Lay-
ers panel by clicking on those eye icons, 
or the eye icon next to Effects to hide/
show them all. After you click OK and 
apply these effects, you can bring back 
the Layer Style dialog to make changes 
by going to the Layers panel and double-
clicking right on the layer style’s name.
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Step One:
Open an image that has a Background 
layer and an object, some type, or a 
photo on its own layer above the back-
ground image. In this case, we have a 
passport stamp graphic that appears 
on its own layer above the Background 
layer (as seen here). That’s the object we 
want to resize. So, start by going to the 
Layers panel and clicking on the stamp’s 
layer to make it the active layer. 

Step Two:
To resize (scale) this graphic image down 
in size, press Command-T (PC: Ctrl-T) 
and it brings up the Free Transform 
boundary box—you’ll know it’s in place 
because it puts control handles all the 
way around whatever is on the layer (as 
seen here). To make the stamp smaller 
(scale it down in size), click on any of 
the corner handles and drag inward (as 
shown here). The farther you drag, the 
smaller the stamp on this layer becomes. 
You can scale things down with hardly 
any visible loss of sharpness, but if you 
make something larger (more than 20% 
or 30% larger), it might start to look a 
little soft and pixelated. Just a heads-up, 
so you don’t go scaling things way up 
and then wonder why they look really 
soft. When you’re done resizing, press 
the Return (PC: Enter) key to lock it in.

Resizing Something on a Layer
You’ll learn in another chapter how to resize your image document, but what 

if you don’t want to resize the document, just something on one of the layers? 

It’s super-easy, but not really obvious if you haven’t done it before.
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Step One: 
There are 21 layers in the document 
I’m working on here. If you look at the 
Layers panel on the left, you can see 
the long, scrolling list of layers, and be-
lieve it or not, it doesn’t take long to 
wind up with 21 layers—I’ve had docu-
ments with 50–60 layers. Luckily, just 
like we have folders on our computers 
to stay organized, we can have fold-
ers for layers, too, but they’re called 

“groups.” So, a bunch of layers in a folder 
is called a “layer group.” To create one, 
select the layers you want in a group by 
Command-clicking (PC: Ctrl-clicking) 
on them in the Layers panel. Then, at 
the bottom of the panel, click on the 
Create a New Group icon (it looks 
like a folder), and it puts those selected 
layers into a group (as seen here, in the 
middle, where I selected all my graphic 
layers and put them into a group). By 
default, it’s named “Group 1,” but I rec-
ommend renaming it something more 
helpful (just double-click directly on 
Group 1, and it highlights the text, so 
you can type in a new name). Look at 
the Layers panel on the right, and you 
can see what it looks like once I also 
put all my Type layers in a group and 
renamed it. It’s nice and easy to get 
around now. To look inside a group (to 
see all its layers), just click on the little 
right-facing arrow to the left of its name 
to expand it. To remove a layer from a 
group, just click on the layer and drag 
it out of the folder.

When you create a bunch of layers, your Layers panel starts to get really long, and you’ll end up scrolling 

up and down a long list just to find the layer you want. But, there’s a very easy way to cut down on all the 

clutter and bring some sanity back into your Layers panel when you have a bunch of layers in there.

Organizing Your Layers

Working with Layers 133Chapter 5

The Adobe Photoshop Book for Digital Photographers

Sam
ple

 p
ag

es



Adjustment Layers
Adjustment layers allow you to not only have an “undo” for any tonal adjustments you make (like brightening or 

darkening your image, or adding contrast, etc.), but they also give you the ability to edit those things forever. Think 

about this: You have a certain amount of undos while you’re working in Photoshop, right? But, what happens when 

you close that document and reopen it later? Those undos are gone, right? Well, that’s just one of the benefits of 

these non-destructive adjustment layers—you can use them as undos that last forever. So, if you reopen that 

same document a week or a year later, you can still edit or even completely undo those tonal changes.

Step One:
To see the adjustments you can apply as 
adjustment layers, click on the Create 
New Adjustment Layer icon (the half 
white/half black circle) at the bottom of 
the Layers panel. In the pop-up menu 
that appears, choose the adjustment 
you want (I chose Curves here), and 
the Properties panel appears, with that 
adjustment’s options (as seen here on 
the right). Creating an adjustment layer 
adds a new layer to your Layers panel 
with a little icon, so you know which 
adjustment you applied (you can see 
the little Curves icon in the next step). 

Step Two:
A nice feature of adjustment layers is 
that they come with a layer mask, so 
you can use the Brush or the Gradi-
ent tools if you only want parts of your 
image to get this adjustment (see page 
120 for more on layer masks). To re-edit 
the curve (or whichever adjustment you 
chose), double-click on this layer and 
the Properties panel reopens with the 
last settings applied still in place so you 
can edit them, or you can delete the 
layer altogether by dragging it onto the 
trash icon at the bottom of the Layers 
panel. You can change the amount of 
the adjustment using the Opacity setting 
for this layer, and you can change its look 
by changing its layer blend mode. Plus, 
because this is a layer, when you save the 
file as a PSD (a Photoshop document), 
the adjustment layer is saved with it, so 
it gives you an undo that lasts forever.
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Step One: 
To create a Smart Filter layer, go under 
the Filter menu, and up near the top, 
choose Convert for Smart Filters, 
which converts your regular layer (in this 
case, our Background layer) into a Smart 
Object layer. You’ll see a little page icon 
in the bottom-right corner of the layer’s 
thumbnail letting you know it’s a Smart 
Object Layer. You can now apply any of 
Photoshop’s filters from the Filter menu.

Step Two:
I chose Camera Raw Filter, which lets 
you apply Camera Raw as if it was a filter. 
In Camera Raw, I clicked on the B&W 
button for a quick black-and-white con-
version of the color image seen in the 
thumbnail in Step One, and tweaked 
a few other settings. If you look at the 
Layers panel here, you can see right 
below the image layer, there’s now a 
layer mask, so I could leave part of this 
image in color by painting on that mask. 
I can hide this filter by clicking on the 
eye icon to the left of “Smart Filters,” 
and if I double-click on “Camera Raw 
Filter,” it reopens the Camera Raw Filter 
window with all my previous settings 
still in place. I can also delete this layer 
altogether (hence the non-destructive 
part) by dragging it onto the trash icon 
at the bottom of the panel, and I can 
save this document as a PSD to keep 
this editable feature for use in the fu-
ture. Again, these are very much like 
adjustment layers, but for filters.

Smart Filter layers are much like the adjustment layers you just learned about on the previous page, but instead 

of just giving you infinitely editible (or deletable) tonal adjustments, like Curves and Levels, these layers let you do 

pretty much the same thing with most of Photoshop’s filters, including applying Camera Raw as filter. Once you create 

a Smart Filter layer, the filter you apply takes on all the same features as an adjustment layer, and the big thing is, it’s 

also non-destructive—it’s always undoable and re-editable, or you can delete it altogether. Here’s how to use them:

Smart Filter Layers
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Step One:
Here’s our background image. I like this 
particular background because we have 
a foreground area that’s in focus (the 
light bulbs right up front), and then the 
background behind them is nice and 
out of focus, so it’ll make a realistic 
background for a composite. So, step 
one is to open a background image (and, 
of course, I made this image available for 
you to download on the book’s compan-
ion webpage. You can find the down-
load link in the book’s introduction). 

Step Two:
Next, let’s open the subject image we 
want to composite onto the background. 
In this case, our subject was shot on a 
gray roll of seamless paper, and Photo-
shop loves a neutral color like that (or 
just any solid-colored wall) when you’re 
trying to remove someone from a back-
ground. That’s one reason why I shoot 
on gray seamless paper so often—it 
makes removing my subject from the 
background really easy. In fact, all you 
need to do is go under the Select menu 
and choose Subject (as shown here) 
and Photoshop will use its AI power to 
recognize that it’s a person in the photo 
and put a selection around them for you, 
hair and all, and it does a pretty decent 
job of it (although, in a later chapter, 
we’ll go in-depth on taking tricky hair 
selections up a big notch, but for every-
day stuff like this, Select Subject does a 
decent job).

Making a composite, where you take your subject (or part of one image) and put them on an entirely different background 
is incredibly popular and surprisingly easy. There are a few things you need to watch out for, and there are a couple of 
little tricks you can do to help make the final composite look realistic, but they really make a big difference. Here, we’re 
going to create a simple composite where we have Photoshop select our subject for us (with it doing all the work), then 
we’ll copy-and-paste our subject onto a different background, and then we’ll use a little color trick to bring it all together.

Making a Simple Composite
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Step Three:
Now that our subject is selected, press 
Command-J (PC: Ctrl-J) to put her up 
on her own separate layer above the 
Background layer. It’s hard to see that 
our subject is isolated while the original 
Background layer is still visible, so go 
to the Layers panel and click on the 
eye icon to the left of the Background 
layer to hide it from view (as seen here). 
Now we see our subject on a transpar-
ent background (that gray-and-white 
checkerboard she’s on indicates the 
transparent areas). You’ll notice it did a 
decent job on her hair here, but in the 
next step, we’ll do a little trick I’ve been 
using for years that fills in any gaps, 
particularly around the edges, and 
makes the selection that much stronger. 

Step Four:
The trick is to duplicate the subject layer 
twice (so you have three layers in all), 
so press Command-J (PC: Ctrl-J) twice. 
This “builds up” any pixels that tend to 
fall out along the edges of the hair, and it 
does a great job of just filling things in (as 
seen here). By the way, at this small size, 
it might not be as apparent, but when 
you try it on your own computer, you’ll 
really see the difference I’m talking about. 
This is so worth doing. Now that we have 
this buildup, we want to combine these 
three subject layers into a single layer, so 
press-and-hold the Command (PC: Ctrl) 
key, and then in the Layers panel, click 
on the other two subject layers (Layer 1 
copy, and Layer 1). With all three selected, 
press Command-E (PC: Ctrl-E) to com-
bine them into a single layer. Now, let’s 
Copy that subject layer into memory by 
pressing Command-C (PC: Ctrl-C). Okay, 
that’s the hard part (I told you this was 
simple); now onto the fun part.
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Step Five:
Now, let’s go back to our background 
image document and press Command-
V (PC: Ctrl-V) to Paste our subject onto 
that background. Get the Move tool 
from the top of Toolbox (you can press 
the V key on your keyboard as a short-
cut), and let’s click-and-drag her up a 
little in the image, so that the top of her 
hat extends out of the top of the frame 
(as shown here). In the Layers panel, 
you’ll see a new layer with her on it. Now, 
if you look at the right side of the image, 
you’ll see that the ends of her hair have a 
bit of a glow or fringe around them, but 
there are a couple of quick tricks we can 
do that will generally help in situations 
like this (again, we’ll cover tricky hair 
selections later on). 

Step Six:
The first thing I would try is a feature 
that often helps remove that glow or 
fringe look. So, go under the Layer 
menu, and at the very bottom, under 
Matting, choose Defringe. When its dia-
log appears, enter 3 pixels for starters 
(as seen in the inset), click OK, and see 
if that does the trick. If it’s not enough, 
press Command-Z (PC: Ctrl-Z) to Undo 
and try it again with a higher number 
(like 5 pixels or 10 pixels). In this case, 
while it did help, it didn’t totally fix it, 
so let’s undo it and try another method. 
Go under the Layer menu again, under 
Matting, but this time choose Remove 
White Matte (as shown here), and it 
replaces those lighter edge pixels with 
a darker color. In this case, that worked 
pretty well, but it just depends on the 
image (sometimes it’s awesome; some-
times it’s awful. Again, it just depends 
on the image). 
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Step Seven:
When I’m toward the end of a composite, 
I do a little move that unifies the subject 
with the background, which helps make 
the subject look more like they’re really 
in that scene. What I do is, I apply a 
color toning to the entire image, and it 
really brings things together. We’ll use 
the Creative Profiles inside Camera Raw 
to do this, but first, we need to merge 
the two layers we have into a single 
Background layer, so when we apply the 
effect, it applies it to both at the same 
time. So, with your subject layer active 
in the Layers panel, press Command-E 
(PC: Ctrl-E) to merge it with the Back-
ground layer below it. Now, we can 
go under the Filter menu and choose 
Camera Raw Filter. When its window 
appears, in the Edit panel, to the right 
of the Profile pop-up menu, click on the 
icon with the four small squares. This 
brings up the Profile browser (as seen 
here). There are four sets of Creative 
Profiles and you can see a live onscreen 
preview of any one of them by just hov-
ering your cursor over a thumbnail. Here, 
I went down to the Vintage collection 
of profiles and the one I liked best was 
Vintage 04 (as seen above). When you 
click on it, it applies that color toning to 
the entire image, which helps to visually 
unify your subject in the foreground with 
the background.

Step Eight:
After you’ve applied the profile, click 
on the Back arrow at the top left of the 
Profile browser to close it. Then, to finish 
things up, let’s add a finishing move that 
I do to nearly every portrait to help focus 
the attention on the subject. Go down to 
the Effects panel and drag the Vignett-
ing slider just a bit to the left to subtly 
darken the outside edges all the way 
around the image (here, I dragged it to 
–18). Click OK to close Camera Raw and 
we’re done with our simple composite.
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These are a few more of those thing you’ll want to know to make your layers life more complete 

(and it’ll keep you from having to scour the web to find out how to do them). Here we go:

Four MORE Important Layers Techniques

#1: Create a Layer That Looks Like 
You Flattened It (But Didn’t)

Sometimes you want to apply an ef-
fect to the entire image, but you don’t 
want to flatten your image and lose the 
flexibility of having all your layers. This 
shortcut creates a new layer on top of 
your layer stack that looks like a flat-
tened version of your image (as seen 
here), so you can apply your filter or 
effect or whatever to it. But, below it, 
are all your original layers. So, if you 
need to go back for any reason, you can 
hide this merged layer, or even delete 
it, and below it, your original layers are 
still there. The shortcut is Command-
Option-Shift-E (PC: Ctrl-Alt-Shift-E). 

#2: Skip the Trip to the Layers 
Panel and Just Jump to 
Any Layer You Want

This is a shortcut I use everyday because 
it saves you a trip to the Layers panel 
when you want to change to a different 
layer. Just press-and-hold the Com-
mand (PC: Ctrl) key, and in the image 
itself (not in the Layers panel), click right 
on the object you want to work with 
and it jumps to that layer. Here, you can 
see my cursor clicking on the bowl and, 
instantly, that becomes the active layer 
in the Layers panel. So now, it’s just 
a quick Command-click (PC: Ctrl-click) 
right on the image and—boom—you’re 
on that layer. 
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#3: Why Smart Object Layers Rule!
We looked at creating a Smart Object 
layer (on page 135), where if you applied 
a filter to your layer, you could always go 
back and edit that filter or even delete 
it at any time. Well, another big benefit 
happens when you resize something on 
a layer. Scaling something down in size 
on a layer isn’t an issue, but if you make 
it larger, your image can become blurry 
and pixelated. However, if you bring an 
image into your document using Place 
Embedded (under the File menu), it be-
comes a Smart Object layer and embeds 
a copy of the original high-res file inside 
your document. That way, if you scale 
the image on that layer up in size, it calls 
on that embedded high-res version, so 
the quality is maintained. They’re also 
super-handy for making templates be-
cause you can Right-click on a Smart 
Object layer, choose Replace Contents, 
then choose a different image, and it 
will appear in that exact same size and 
position in your document. 

#4: See Just the Layers You Want 
(Filtering Your Layers)

Once you get a lot of layers, things can 
look really messy in your Layers panel, 
but there’s a filter you can use to help 
cut the clutter. The row of icons at the 
top of the panel let you see only a par-
ticular type of layer. Let’s say you just 
want to see your Type layers (no others). 
Click the Type Layers icon (as shown 
here, on the left), and now you only see 
Type layers. These icons are for filtering 
for (L to R): Image layers, Adjustment lay-
ers, Type layers, Path layers, and Smart 
Object layers. Another way to filter is by 
using the Kind pop-up menu. Here (on 
the right), I chose to see just layers with 
a Drop Shadow effect. You can even 
search by a layer’s name (choose Name 
from that pop-up menu, and a text field 
appears for you to type in the layer’s 
name). By the way, that red switch to the 
right toggles the filter on/off.
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